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Introduction

Qualified Persons  WARNING
Only qualified persons who are knowledgeable in the installation, operation, and 
maintenance of overhead and underground electric distribution equipment, along 
with all associated hazards, may install, operate, and maintain the equipment 
covered by this publication . A qualified person is someone who is trained and 
competent in:

• The skills and techniques necessary to distinguish exposed live parts from nonlive 
parts of electrical equipment

• The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualified person will be exposed

• The proper use of special precautionary techniques, personal protective  
equipment, insulated and shielding materials, and insulated tools for working on 
or near exposed energized parts of electrical equipment

These instructions are intended only for such qualified persons . They are not 
intended to be a substitute for adequate training and experience in safety  
procedures for this type of equipment .

Read this  
Instruction Sheet

NOTICE
Thoroughly and carefully read this instruction sheet and all materials included in 
the product’s instruction handbook before installing or operating the IntelliCap 2000 
Automatic Capacitor Control Familiarize yourself with the Safety Information and 
Safety Precautions on pages 4 through 5 . The latest version of this publication is 
available online in PDF format at sandc.com/en/support/product-literature/ .

Retain this  
Instruction Sheet

This instruction sheet is a permanent part of the IntelliCap 2000 Automatic Capacitor 
Control. Designate a location where users can easily retrieve and refer to this publication.

Proper Application  WARNING
The equipment in this publication must be selected for a specific application . The 
application must be within the ratings furnished for the selected equipment . Refer 
to S&C Descriptive Bulletin 1024-30 .
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Introduction

Special Warranty 
Provisions

The standard warranty contained in S&C’s standard conditions of sale, as set forth in 
Price Sheets 150 and 181, applies to the IntelliCap 2000 Automatic Capacitor Control, 
except that the first paragraph of the said warranty is replaced by the following:

(1) General: The seller warrants to the immediate purchaser or end user for a period of  
10 years from the date of shipment that the equipment delivered will be of the 
kind and quality specified in the contract description and will be free of defects of 
workmanship and material. Should any failure to conform to this warranty appear 
under proper and normal use within 10 years after the date of shipment, the seller 
agrees, upon prompt notification thereof and confirmation that the equipment has 
been stored, installed, operated, inspected, and maintained in accordance with 
the recommendations of the seller and standard industry practice, to correct the 
nonconformity either by repairing any damaged or defective parts of the equipment 
or (at the seller’s option) by shipment of necessary replacement parts. The seller’s 
warranty does not apply to any equipment that has been disassembled, repaired, or 
altered by anyone other than the seller. This limited warranty is granted only to the 
immediate purchaser or, if the equipment is purchased by a third party for instal-
lation in third-party equipment, the end user of the equipment. The seller’s duty to 
perform under any warranty may be delayed, at the seller’s sole option, until the 
seller has been paid in full for all goods purchased by the immediate purchaser. No 
such delay shall extend the warranty period.

Replacement parts provided by the seller or repairs performed by the seller 
under the warranty for the original equipment will be covered by the above special 
warranty provision for its duration. Replacement parts purchased separately will 
be covered by the above special warranty provision.

Warranty of the IntelliCap 2000 Automatic Capacitor Control is contingent upon 
the installation, configuration, and use of the control or software in accordance 
with S&C’s applicable instruction sheets.

This warranty does not apply to major components not of S&C manufacture, 
such as communication devices. However, S&C will assign to the immediate 
purchaser or end user all manufacturer’s warranties that apply to such major 
components.

Warranty of equipment/services packages is contingent upon receipt of adequate 
information on the user’s distribution system, sufficiently detailed to prepare a 
technical analysis. The seller is not liable if an act of nature or parties beyond 
S&C’s control negatively impact performance of equipment/services packages; for 
example, new construction that impedes radio communication, or changes to the 
distribution system that impact protection systems, available fault currents, or 
system-loading characteristics.
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Safety Information
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Understanding  
Safety-Alert 
Messages

Several types of safety-alert messages may appear throughout this instruction sheet 
and on labels and tags attached to the IntelliCap 2000 Automatic Capacitor Control. Be 
familiar with these types of messages and the importance of the various signal words: 

 DANGER
“DANGER” identifies the most serious and immediate hazards that will result in 
serious personal injury or death if instructions, including recommended precautions, 
are not followed .

 WARNING
“WARNING” identifies hazards or unsafe practices that can result in serious  
personal injury or death if instructions, including recommended precautions, are 
not followed .

 CAUTION
“CAUTION” identifies hazards or unsafe practices that can result in minor personal 
injury if instructions, including recommended precautions, are not followed .

NOTICE
“NOTICE” identifies important procedures or requirements that can result in  
product or property damage if instructions are not followed .

Following Safety 
Instructions

When any portion of this instruction sheet is not understood and assistance is required, 
contact the nearest S&C Sales Office or S&C Authorized Distributor. Their telephone 
numbers are listed on S&C’s website sandc.com, or call the S&C Global Support and 
Monitoring Center at 1-888-762-1100.

NOTICE

Read this instruction sheet thoroughly and carefully 
before installing the IntelliCap 2000 Automatic 
Capacitor Control .

Replacement 
Instructions  
and Labels

If additional copies of this instruction sheet are needed, contact the nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be replaced 
immediately. Replacement labels are available by contacting the nearest S&C Sales Office, 
S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.



  DANGER
The IntelliCap 2000 Automatic Capacitor Control line voltage input range is 
93 to 276 Vac. Failure to observe the precautions below will result in serious 
personal injury or death.

Some of these precautions may differ from company operating procedures and rules . 
Where a discrepancy exists, follow the company operating procedures and rules .

1 . QUALIFIED PERSONS. Access to an IntelliCap 2000 
Automatic Capacitor Control must be restricted only to 
qualified persons . See the “Qualified Persons” section 
on page 2 .

2 . SAFETY PROCEDURES. Always follow safe operating 
procedures and rules . Always maintain proper 
clearance from energized components .

3 . PERSONAL PROTECTIVE EQUIPMENT. Always use 
suitable protective equipment, such as rubber gloves, 
rubber mats, hard hats, safety glasses, arc-flash 

clothing, and fall protection, in accordance with safe 
operating procedures and rules .

4 . SAFETY LABELS AND TAGS. Do not remove or 
obscure any of the “DANGER,” “WARNING,” 
“CAUTION,” or “NOTICE” labels and tags . Remove 
tags ONLY if instructed to do so .

5 . MAINTAINING PROPER CLEARANCE. Always 
maintain proper clearance from energized components .

Safety Precautions
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Hardware and Software

This instruction sheet was prepared for use with IntelliCap 2000 control software: 
IC2000Installer-2.3.x or higher.

The software identification is located on the IntelliLink® Setup Software Setup> 
General>Software Versions screen. For questions regarding the applicability of infor-
mation in this instruction sheet to future product releases, please contact S&C Electric 
Company.

 WARNING
These instructions do not replace the need for utility operation standards . Any 
conflict between the information in this document and utility practices should be 
reviewed by appropriate utility personnel and a decision made as to the correct 
procedures to follow .

Serious risk of personal injury or death may result from contact with electric  
distribution equipment when electrical isolation and grounding procedures are 
not followed . The equipment described in this document must be operated and  
maintained by qualified persons who are thoroughly trained and understand any 
hazards that may be involved . This document is written only for such qualified 
persons and is not a substitute for adequate training and experience in safety  
procedures for accessing high-voltage equipment .

This control is connected to capacitors operating at primary voltage levels . High 
voltage may be present in the wiring to the control or the control itself during certain 
failures of the capacitor bank wiring or grounding systems, or because of a failure of the  
capacitor bank itself . For this reason, access to the control should be treated with 
the same safety precautions that would be applied when accessing other high-
voltage lines and equipment . Follow all locally approved safety procedures when 
working on or around this control .

Before attempting to access an existing switch installation, check carefully for  
visible or audible signs of electrical or physical malfunction (do this before touching 
or operating the control or any other part of the installation) . These warning signs 
include such things as smoke, fire, open fuses, crackling noises, loud buzzing, etc . 
If a malfunction is suspected, treat all components of the installation, including the 
control and associated mounting hardware, as if they were elevated to primary 
(high) voltage .

The faceplate LCD screen provides information about the present state of the control. 
For an explanation of the LCD screen and faceplate controls, see the “Faceplate” section 
on page 8.

Applicable Software

LCD Screen

IntelliLink® Setup Software Operation, Diagnostics>Alarms, Metering, and Setup> 
General>Software Versions screens display information about the IntelliCap 2000 control 
operating data and sensor data. For an explanation of these screens, see S&C Instruction 
Sheet 1024-550, “IntelliCap 2000 Automatic Capacitor Control: Troubleshooting.”

Viewing Control Data
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Hardware and Software

Hardware  
Components

Figure 1. Capacitor control components.

SCADA port—When the control includes communication equipment, it will usually be 
connected to the SCADA PORT.

Terminal strip—The terminal names are shown on a label inside the enclosure.  
If necessary, reconfigure the wiring to the meter base or the connectors on the bottom 
of the enclosure.

Test points—These are labeled at the bottom of the faceplate and are used to check 
inputs to the control.

Load fuse

Test points

Terminal strip

SCADA port

Ethernet port

This section describes control hardware. The “Control Operation” section that starts on  
page 14 explains how these components work together to monitor the distribution feeder 
and manage capacitor bank operation. Figure 1 shows parts needed to access during regular  
operation and troubleshooting.

To view these screens, a Windows 7 or later computer, Microsoft® Edge, a USB 
2.0 A to B cable, and IntelliLink Setup Software for the IntelliCap 2000 control 
are required. For more information about the required equipment and how to use 
IntelliLink Setup Software, see S&C Instruction Sheet 1024-530, “IntelliCap® 2000  
Automatic Capacitor Control:  Setup.”

The electrical interconnect diagrams, at the back of S&C Instruction Sheet 1024-510,  
IntelliCap 2000 Automatic Capacitor Control: Installation,” show IntelliCap 2000 control  
wiring layouts.

Test points are accessible below the faceplate. See Figure 1.

Electrical Diagrams

Test Points
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Hardware and Software

The IntelliCap 2000 control faceplate includes LEDs and buttons used to monitor and 
control the bank. The scroll buttons at the right are used for selecting data on the LCD 
screen. See Figure 2. 

Faceplate

Figure 2. The faceplate controls and indicators.

Faceplate LED Indicators and Control Buttons

Last Bank Command: Close/Open
These indicators show the present position of the capacitor bank, unless a problem 
prevented bank operation. To initiate a Close or Open command, make sure the SCADA 
CONTROL: LOCAL indicator is in the On state and the OPERATION MODE: MANUAL 
indicator is in the On state, and then press the CLOSE or OPEN button. When automatic 
operation or remote operation is enabled, commands from the faceplate CLOSE and 
OPEN buttons are blocked.
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Hardware and Software

Operation Inhibited
When lit, this indicator shows Automatic Operation mode is presently blocked.

SCADA Control: Remote/Local
These indicators show whether remote operation of the bank via SCADA is allowed.  
To change the state, press this CHANGE button.

SCADA Communications: XMT/RCV
These indicators blink when the control sends or receives one or more characters in a 
transmission. They only blink if remote communication equipment is installed, properly 
connected, and receiving power.

Lamp Test
Press this button to test LEDs on the faceplate. All LEDs should illuminate.

Switch Position Inputs: Open/Closed
When digital switch position inputs are enabled and the physical inputs are  
connected to a dry position contact on the capacitor switch, these indicators show the 
state of the closed and open digital input terminals 3 and 4 on the input terminal block. 
Terminal 1 is the return. The Switch Position Input settings are configured on the Setup> 
General>Site-Related screen.

The Faceplate LCD
The LCD screen is a 2-line, 16-character display. When the control is operating normally, 
the top line reads **Unit OK**. The bottom line cycles through a list of real-time data, 
setpoints, and logged data, as well as other operating information, such as an active 
alarm or a reclose block.

Reclose Block
When the Reclose Block mode is enabled, the LCD screen shows information on both 
lines. See Table 1. When Reclose Block mode is enabled, the Reclose Block timer can 
only be cleared from the faceplate and only when the control is in the Manual Operation 
state and Local SCADA Control state.

Operation Mode: Auto/Manual
These indicators show whether operation of the capacitor control is automatic or manual. 
To change the state, make sure the SCADA CONTROL: LOCAL indicator is in the On 
state. Then, press the CHANGE button.

NOTICE
When Automatic Operation mode is enabled, the Automatic-Control logic may 
switch the capacitor bank regardless of whether SCADA Control mode is enabled 
or disabled . To have full local control of the capacitor bank, the MANUAL LED must 
also be lit .
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Table 1. Reclose Block Messages on the LCD Screen
Display Meaning

[RECLOSE Blk: ###] After opening the capacitor bank, the control will not reclose it for 
the duration of the reclose block timer . The default setting is 5 
minutes . This allows the capacitors to discharge .

[RECLOSE Blk: ### 
Man ENTER=Cancel]

[Sel Code & Enter 
Code: 0]

The first message appears if the Reclose Block Reset Password 
function is enabled and an attempt is made to close the bank 
while the reclose block is in effect . To bypass the block, press the 
faceplate ENTER button . Use the + and – keys to scroll through 
the password list, then press the ENTER button when the LCD 
screen shows the correct password . To end the procedure without 
bypassing the block, press the ESC button .

Real-Time Data
To access the Real-Time Data, press the NEXT button from top level menu. The top 
level menu typically reads **Unit OK** unless there is an active Alarm, Warning, or 
Error condition. To ensure the top level menu is displayed, press the ESC button. When 
the Real-Time Data menu is displayed, the LCD screen will read **Menu** on the top 
line and **Data** on the bottom line. Use the + and – keys to move through the menu.

Hardware and Software
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Hardware and Software

Table 2. Real-Time Data Displayed on the LCD  Screen (For a Var Control with 
Current Sensing)

Display Meaning

[Date] The date today

[Time] Present time

[Volt]; [Ovr] Line voltage (true RMS measured voltage) and shows that a voltage 
override is in effect

[Current] Var controls only—Current level, in amperes

[Neu Fund] Neutral amps (or voltage) fundamental

[Temperature:] Present ambient temperature in ºF

[Temperature:] Present ambient temperature in ºC

[kVARs] Var controls only—kvar level

[kW] Var controls only—real power level

[kVA] Var controls only—kVA level

[PFactor] Power factor

[Line kV] Var controls only—Voltage level on the distribution line, in kV

[C . Phase] Var controls only—Corrected phase angle

[Phase] Var controls only—Uncorrected phase angle

[AkVars] Var controls only—Adjusted kvars

[Curr Dir] Var controls only—Current flow direction

[FPnl Edit] LCD edit enabled/disabled

[Daily Cycles] Daily automatic cycles

[Ann . Cycles] Total operations this year (or since upgrade)

Note: The kvar level shown is calculated from measured sensor values; it is not an 
adjusted level.

Alarms
When any Alarm, Warning, or Error state is active, the LCD screen shows the high-
level state on the top line. Any additional alarms, warnings, or errors can be viewed by 
pressing the NEXT button twice and using the + and – keys to scroll through the alarms 
list. When the LCD screen shows the Alarms menu, the top line will display **Menu** 
and the bottom line will display **Alarm**. See Table 3 on page 12. To clear a Neutral 
Sensing Lockout condition, press the OPERATION MODE: CHANGE button until the 
LED screens have cycled from Manual to Auto mode and back to the Manual mode.

S&C Instruction Sheet 1024-540  11



Hardware and Software

Table 3. Alarms Displayed on the LCD Screen

Display Meaning

TempSensorErr The temperature sensor is reading outside of its range or may be faulty

VoltageDeltaErr
A Low Switching Voltage Delta message appears when the actual 
change in voltage levels during switching is below the minimum 
percentage of the expected change

VoltageBandErr

The Bank Voltage Change + Margin value has exceeded the Season 
Override High/Low Voltage differential . The bank switch is not locked out 
until the High/Low Band Error has existed continuously for High/Low Band 
Lockout Time Threshold time . At that point the Voltage Band Lockout 
error is set and the bank switch is locked out .

VarDeltaErr
A Low Switching Kvars Delta message appears when the actual change 
in kvar levels during switching is below the minimum percentage of the 
expected change

VoltageSensorErr The voltage sensor is reading outside of its range or may be faulty

LoadFuseErr Blown load fuse

VoltRangeErr

This error indicates a possible mismatch between the configured 
nominal operating voltage setting and actual system voltage as sensed 
by the control . It is not indicative of a line problem . When the control 
is configured for a nominal operating voltage of 220 V or higher and it 
senses a secondary voltage that is below 176 V, or when the control is 
configured for a nominal operating voltage of 127 V or lower and senses a 
secondary voltage higher than 152 V, this error becomes active

MaxAutoCyclesErr The control reached the Maximum Automatic Control Cycles Per Day 
setting . Further automatic switching is inhibited until the next calendar day

NeutralSensorErr
Neutral sensing controls only . This message is displayed before the 
control locks out the bank following a neutral current or neutral voltage 
alarm

NeutLockoutErr

Neutral sensing controls only . The level of neutral current or neutral 
voltage has caused the control to lock out the bank . S&C Instruction  
Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: Setup,” 
for more details

NeutralZeroErr

Neutral sensing controls only . The control detected zero neutral current or 
neutral voltage for the length of the Zero Neutral Detection setpoint . See 
S&C Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor 
Control: Setup,” for more details

LoadFuseAlarm The load fuse on the faceplate has blown
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Hardware and Software

IntelliLink Setup Software can be downloaded at the S&C Automation Customer Support 
Portal: sandc.com/support/automation-customer-support-portal.asp. This software 
runs on computers using Windows® operating system with a USB cable to communicate 
with the control. Use the software to:

• Change strategy (for example, from Temperature to Time-Biased Voltage strategy)

• Enter installation-dependent operating parameters (setpoints), such as a network 
address, the temperature-change time threshold, a voltage-override level, etc.

• Monitor real-time data, such as the present line voltage and current

• Examine the performance and operating history of an installed capacitor control

• Transfer all configuration, operating, and historical data from the capacitor control 
to a report file on the computer

• Download new control software into the capacitor control

• Troubleshoot assorted types of capacitor control installation problems

Most utility communication equipment can be mounted inside the enclosure on the back 
of the door. This eliminates pole clutter and provides a higher reliability level for the  
installation.

DNP 3.0 is the standard protocol for the IntelliCap 2000 Capacitor Control. See  
Instruction Sheet 1024-561, “IntelliCap® 2000 Automatic Capacitor Control: DNP Points 
List and Implication” for more information.

IntelliLink Setup 
Software

SCADA 
Communication 
Equipment

S&C controls are entirely software-driven. The control software is pre-loaded into the 
control at the factory. The control software manages the minute-by-minute functioning 
of the control. It continually monitors:

• Voltage, current, or neutral current/neutral voltage on the feeder

• Incoming SCADA commands

• State of the faceplate LED screens and buttons

• Ambient temperature at the control

• Internal capacitor control clock/calendar

• Software setpoint values

• Various other setpoints and data values as needed

Based on this information, the control software decides how to respond to a change in  
voltage, a command from the faceplate or SCADA master station, and other conditions.

The control software, the setpoint values, and historical data are all stored in non- 
volatile flash memory, which survives power interruptions.

Control Software
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Control Operation

The control operation section explains how the capacitor control components work 
together to control the capacitor bank.

Signal Processing
The capacitor control reports voltage, current, and phase-related data in units of volts, 
amperes, kvars, kW, and kVA. The rated accuracy of these measurements is based on the 
combined accuracy of all the control components (exclusive of the sensor and sensor cable but  
including all sensor conditioning components).

Voltage readings are accurate for all distribution voltages. For var controls, phase-angle 
detection requires a minimum current of 0.5% of Full Scale values. Current magnitudes 
are still detected and displayed below the 0.5% threshold. The capacitor control uses the 
phase-angle offset values to calculate all ac waveform data sampled from the line sensor.

RMS Ac Displayed and Recorded Values
For real-time, steady-state monitoring and data logging, the capacitor control collects 
data at 0.3-second intervals. It then averages four samples and reports the 1.2-Second 
Averaged value. This results in a 1.2-second net response time.

The control uses these 1.2-Second Averaged values for the real-time display,  
reporting via the faceplate, SCADA communications, and most data logging. Daily highs 
and lows are the highest and lowest Raw Sample (unaveraged) values; they are stored 
for the present day and the preceding 31 days.

The control also uses these 1.2-Second Averaged values to create Interval  
Averaged values (data averaged over the logging interval) for voltage and temperature, 
as well as current, kvars, power factor, kW, and neutral current/neutral voltage, if appli-
cable. Choose a data-logging interval of 1, 5, 10, 15, 30, or 60 minutes. The period of logged 
Interval Averaged values depends on the chosen interval.

The control data logged values of voltage and current are RMS values.

Bank switching is based on voltage and current measurements on the fundamental  
frequency and is not affected by harmonics.

Neutral current switching is also based on the fundamental frequency and is not 
affected by harmonics. The control data logs the fundamental component of the neutral 
current.

Phase-Angle Measurements
The var capacitor controls calculate the phase angle between the voltage and current 
waveforms. Phase-angle measurements are on a 0-360 degree range.

As part of the capacitor control setup, enter an Installation Phase Offset Angle 
setpoint to compensate for various installation-dependent phase angle errors.

Data Acquisition
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The IntelliCap 2000 control can switch the capacitor bank automatically using a variety of 
control strategies: Temperature, Timeclock, Timeclock with Temperature Override, 
Voltage Only, Time-Biased Voltage, Time-Biased Temperature, Automatic Offline, 
or Automatic Online strategy. Var controls have four additional control strategies: 
Current, Current with Temperature Override, Var, and Var with Temperature 
Override strategy. These are all explained in this section. For information about how 
to use the faceplate buttons to enable Automatic Operation mode, see the “Switching 
the Capacitor Bank” section on page 35.

The capacitor control switches the bank based on a prioritized set of conditions. These 
conditions, from highest to lowest priority, are:

Reclose Block—After opening the capacitor bank, the control will not reclose it until the 
Reclose Block timer expires. The default setting is 5 minutes. This allows the capacitors 
to discharge. The bottom line of the LCD screen shows the time remaining before the 
control can switch the bank in. The time remaining also appears in the Reclose Block 
field on the Operation screen. Reclose Block mode is active only when the control is in 
the Manual Operation state and the SCADA Local state.

Control Strategies

Control Operation

State of the Faceplate LEDs—If the MANUAL LED is lit, the capacitor control blocks 
the Automatic Operation mode. The bank can only be operated from the faceplate 
CLOSE and OPEN buttons or from the Operation screen when the LOCAL LED is lit.

Remote Commands—If the REMOTE LED and the MANUAL LED are both lit, the 
capacitor control accepts commands from the SCADA master station.

Anti-Cycling Limit—If the capacitor control is in Automatic Operation mode, the 
Maximum Automatic Control Cycles Per Day setpoint on the Setup>General screen 
determines the maximum number of automatic switching cycles per calendar day. Once 
this limit is reached, the capacitor bank remains switched out until the next calendar day.

Emergency High-Voltage and Emergency Low-Voltage Override Setpoints—If the 
voltage remains outside the emergency override range for a specified period of time, the 
capacitor control switches the bank. See the Setup>General screen in S&C Instruction 
Sheet 1024-530, “IntelliCap 2000 Automatic Capacitor Control: Setup” for more details.

High-Voltage and Low-Voltage Override Setpoints—If the voltage remains outside the 
normal range for a specified period of time, the capacitor control switches the bank. See 
Setup>General screen in S&C Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic 
Capacitor Control: Setup” for more details.

The Present Control Strategy—The capacitor control switches the bank according 
to the strategy presently in effect.

If the capacitor control has been in Manual Operation mode and is returned to  
Automatic Operation mode, it waits 60 seconds before switching the bank, when  
necessary. This timer is not configurable. This allows the operator to step away from 
the bank before it operates.
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Temperature Control Strategy
When the Automatic Operation function is enabled and the capacitor control is 
in Temperature strategy, it switches the capacitor bank based on the present air 
temperature. The control can operate in both high- and low-temperature modes. The 
control uses the following logic to determine when to switch the capacitor bank:

STEP  1.  The capacitor control monitors present air temperature.

STEP  2.  When the control senses the temperature has passed the Temperature at 
Which Bank Switches In threshold (or the Temperature at Which Bank 
Switches Out threshold), it begins the High-/Low-Temperature Change 
Time Threshold timer. This is true for either high-temperature or low-
temperature operation.

STEP  3.  For high-temperature operation, if the temperature remains continuously 
above the Temperature at Which Bank Switches In threshold for the 
duration of the timer, the control switches the bank in. If it remains below the 
Temperature at Which Bank Switches Out threshold for the duration of the 
timer, the control switches the bank out.

For low-temperature operation, when the temperature remains continu-
ously below the Temperature at Which Bank Switches In threshold for 
the duration of the timer, the control switches the bank in. If it remains above 
the Temperature at Which Bank Switches Out threshold for the duration 
of the timer, the control switches the bank out.

Note: The voltage must remain in a range where switching the capacitor bank will  
not cause a Voltage Override condition. Otherwise, the control will not switch the 
bank to avoid excessive cycling. See the “Voltage Override Operation” section in  
S&C Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: 
Setup,” for details.

Note: A bad temperature sensor does not prevent the control from operating. It will 
still switch the bank if a Voltage Override condition becomes active.

Control Operation
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Control Operation

Time-Biased Temperature Control Strategy
When the Automatic Operation mode is enabled and the capacitor control is in  
Time-Biased Temperature strategy, it switches the capacitor bank based on two sets 
of temperature setpoints. The Time-Biased Temperature strategy uses the same logic 
as the Temperature strategy, except:

• There is only one set of temperature setpoints in use.

• The capacitor bank is in Offline strategy during unscheduled times.

Note: If the bank was in Online mode when the unscheduled period began and the  
temperature does not go beyond the switch-out setpoint, the bank switches back in at 
the start of the next scheduled period. It does not wait for the temperature to go beyond 
the switch-in value.

For example, the bank is set to switch in at 80° F (27°C) and switch out at 70°F  
(21°C). The timeclock schedule period is 8:00-17:00. On Monday at 17:00, the bank switches 
out. During the unscheduled time, the temperature does not go below 70°F (21°C) for the 
length of the Temperature Time threshold. On Tuesday at 8:00, the bank switches in 
again, even if the temperature is below 80°F (27°C).

Note: The voltage must remain in a range where switching the capacitor bank will  
not cause a Voltage Override condition. Otherwise, to avoid excess cycling, the 
control will not switch the bank. See the “Voltage Override Operation” section in  
S&C Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: 
Setup,” for details.

Note: A bad temperature sensor does not prevent the control from operating. It will 
still switch the bank if a Voltage Override condition becomes active.

Timeclock Control Strategy
When the Automatic Operation mode is enabled and the capacitor control is in 
Timeclock strategy, it switches the capacitor bank based on a time schedule. Enter up 
to two different time schedules. The control uses the following logic to determine when 
to switch the capacitor bank:

STEP  1.  The capacitor control checks to determine whether the present time falls 
within one of the scheduled On periods.

STEP  2.  If the present time is within a scheduled On period and the calendar day is not 
a holiday, the control switches the bank in. If the bank is already online, it 
remains online.

STEP  3.  When the time is no longer in a scheduled On period or the calendar day becomes 
a holiday, the control switches the bank out. If the bank is already offline, it 
remains offline.

Note: The voltage must remain in a range where switching the capacitor bank will 
not cause a Voltage Override condition. Otherwise, the control will not switch the 
bank. See the Voltage Override Operation section in S&C Instruction Sheet 1024-530,  
“IntelliCap® 2000 Automatic Capacitor Control: Setup,” for details.

S&C Instruction Sheet 1024-540  17



Control Operation

Timeclock with Temperature Override Control Strategy
When the Automatic Operation mode is enabled and the capacitor control is in 
Timeclock with Temperature Override strategy, it switches the capacitor bank based 
on a time schedule. Up to two different time schedules can be entered. The control uses the  
following logic to determine when to switch the capacitor bank:

STEP  1.  The capacitor control checks to see if the present time falls within one of the  
scheduled “on” periods.

STEP  2.  If the present time is within a scheduled On period and the calendar day is  
not a holiday, the control switches the bank in. If the bank is already online, it 
remains online.

STEP  3.  When the time is no longer in a scheduled On period or the calendar day  
becomes a holiday, the control switches the bank out. If the bank is already 
offline, it remains offline.

STEP  4.  In addition, if the control senses that the air temperature has passed the 
Temperature at Which Bank Switches In threshold (or the Temperature 
at Which Bank Switches Out threshold), it starts the High-/Low-
Temperature Change Time threshold timer. This is true for either high-
temperature or low-temperature operation.

STEP  5.  For high-temperature operation, if the temperature remains continuously 
above the Temperature at Which Bank Switches In threshold for the 
duration of the timer, the control switches the bank in, if it is not already 
switched in. If it remains below the Temperature at Which Bank Switches 
Out threshold for the duration of the timer, the control reverts to operation 
based on Timeclock control settings.

For low-temperature operation, when the temperature remains continu-
ously below the Temperature at Which Bank Switches In threshold for 
the duration of the timer, the control switches the bank in, if it is not already 
switched in. If it remains above the Temperature at Which Bank Switches 
Out threshold for the duration of the timer, the control reverts to operation 
based on Timeclock control settings.

Note: The voltage must remain in a range where switching the capacitor bank will  
not cause a Voltage Override condition. Otherwise, to avoid excessive cycling, the 
control will not switch the bank. See the “Voltage Override Operation” section in S&C 
Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: Setup,” for 
details.
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Voltage Only Control Strategy
When the Automatic Operation mode is enabled and the capacitor control is in  
Voltage Only strategy, it switches the capacitor bank based solely on the High- and 
Low-Voltage setpoints. A preferred capacitor bank position can also be selected. The 
control uses the following logic to determine when to switch the capacitor bank:

STEP  1.  The capacitor control monitors voltage. When voltage remains within the 
normal range, the capacitor control switches the bank based on the Preferred 
Capacitor Bank Position setting. No action is taken if the None position is 
selected or if switching the bank would cause a Voltage Override condition.

To set the Preferred Capacitor Bank Position setting, go to the 
Setup>Seasons>Main screen to see which seasons have a Voltage Only 
Strategy setting. Then, select the tab for that season and select the Preferred 
Capacitor Bank Position setting for that season.

Figures 3, 4, and 5 on page 20 show when the capacitor bank switches for 
each Preferred Capacitor Bank Position setting. The capacitor control uses 
the Voltage Override setpoints and the Bank Voltage Change + Margin 
setting to avoid excessive cycling.

STEP  2.  When the control senses that the voltage has passed the High-Voltage 
Override Value threshold (or Low-Voltage Override Value threshold), it 
starts the High-Voltage Override Time (or Low-Voltage Override Time) 
timer.

STEP  3.  If the voltage remains continuously above the High-Voltage Override Value 
threshold for the duration of the High-Voltage Override Time timer, the 
control switches the bank out. If it remains continuously below the Low-
Voltage Override Value threshold for the duration of the Low-Voltage 
Override Time timer, the control switches the bank in.
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Figure 3. Voltage control switching, preferred capacitor bank position is “None.”

Figure 4. Voltage control switching, preferred capacitor bank position is “Online.”

Figure 5. Voltage control switching, preferred capacitor bank position is “Offline.”
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Time-Biased Voltage Control Strategy
When the Automatic Operation mode is enabled and the capacitor control is in Time-
Biased Voltage strategy, it switches the capacitor bank based on two sets of High- and 
Low-Voltage setpoints. The Time-Biased Voltage strategy uses the same logic as the 
Voltage Only strategy, except:

• The voltage setpoints are different for scheduled and unscheduled times.

• There is only one Voltage Change Time Threshold setting.

• The capacitor control does not use the Preferred Capacitor Bank Position setpoint.

Automatic Offline Control Strategy
When the Automatic Operation mode is enabled and the capacitor control is in 
Automatic Offline strategy, the capacitor bank is always switched out. The control 
does not even switch the bank for a Voltage Override condition. For Automatic Offline 
mode, the bank will NOT switch in for an Emergency Low Voltage Override condition.

If the bank is switched online in Manual mode, the capacitor control switches it back 
offline when it returns to Automatic Operation mode after the 60-second safety delay.

Automatic Online Control Strategy
When the Automatic Operation mode is enabled and the capacitor control is in 
Automatic Online strategy, the capacitor bank is always switched in. The control does 
not even switch the bank for a Voltage Override condition.

If the bank is switched offline in Manual mode, the capacitor control switches it back 
online when it returns to Automatic Operation mode after the 60-second safety delay.

Current Control Strategy (var controls only)
When the Automatic Operation mode is enabled and the capacitor control is in  
Current strategy, it switches the capacitor bank based on measured single-phase  
current flow. The control uses the following logic to determine when to switch the 
capacitor bank:

STEP  1.  The capacitor control monitors the single-phase line current.

STEP  2.  When the control senses the current has passed the Single-Phase Amps at 
Which Bank Switches In threshold (or the Single-Phase Amps at Which 
Bank Switches Out threshold), it starts the Current Change Time 
Threshold Timer function.

STEP  3.  If the single-phase current remains continuously above the Single-Phase 
Amps at Which Bank Switches In threshold for the duration of the timer, the 
control switches the bank in. If it remains continuously below the Single-
Phase Amps at Which Bank Switches Out threshold for the duration of the 
timer, the control switches the bank out.

Note: The voltage must remain in a range where switching the capacitor bank will  
not cause a Voltage Override condition. Otherwise, to avoid excessive cycling, the 
control will not switch the bank. See the “Voltage Override Operation” section in S&C 
Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: Setup,” for 
details.
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Current with Temperature Override Control Strategy (var controls only)
When the Automatic Operation mode is enabled and the capacitor control is in  
Current with Temperature Override strategy, it switches the capacitor bank based 
on measured single-phase current flow. The control uses the following logic to determine 
when to switch the capacitor bank:

STEP  1.  The capacitor control monitors the single-phase line current.

STEP  2.  When the control senses current has passed the Single-Phase Amps at Which 
Bank Switches In threshold (or the Single-Phase Current at Which Bank 
Switches Out threshold), it starts the Current Change Time Threshold 
timer.

STEP  3.  If the single-phase current remains continuously above the Single-Phase 
Amps at Which Bank Switches In threshold for the duration of the timer, the 
control switches the bank in. If it remains continuously below the Single-
Phase Amps at Which Bank Switches Out threshold for the duration of the 
timer, the control switches the bank out.

STEP  4.  In addition, if the control senses the air temperature has passed the 
Temperature at Which Bank Switches In threshold (or the Temperature 
at Which Bank Switches Out threshold), it starts the High-/Low-
Temperature Change Time Threshold timer. This is true for either high-
temperature or low-temperature operation.

For high-temperature operation, when the temperature remains continu-
ously above the Temperature at Which Bank Switches In threshold for 
the duration of the timer, the control switches the bank in, if it is not already 
switched in. When it remains below the Temperature at Which Bank 
Switches Out threshold for the duration of the timer, the control reverts to 
operation based on Current settings.

For low-temperature operation, if the temperature remains continuously 
below the Temperature at Which Bank Switches In threshold for the  
duration of the timer, the control switches the bank in, if it is not already 
switched in. If it remains above the Temperature at Which Bank Switches 
Out threshold for the duration of the timer, the control reverts to operation 
based on Current settings.

Note: The voltage must remain in a range where switching the capacitor bank will  
not cause a Voltage Override condition. Otherwise, to avoid excessive cycling, the 
control will not switch the bank. See the “Voltage Override Operation” section in S&C 
Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: Setup,” for 
details.
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Var Control Strategy (var controls only)
When the Automatic Operation mode is enabled and the capacitor control is in 
Var strategy, it switches the capacitor bank based on single-phase kvars, kilovolt- 
amperes, reactive. The control uses the following logic to determine when to switch the  
capacitor bank:

STEP  1.  The capacitor control monitors the single-phase kvar level.

STEP  2.  When the control senses the kvars have passed the Single-Phase kvars at 
Which Bank Switches In threshold (or the Single-Phase kvars at Which 
Bank Switches Out threshold, it starts the Var Change Time Threshold 
timer.

STEP  3.  If the single-phase kvar level remains continuously above the Single-Phase 
kvars at Which Bank Switches In threshold for the duration of the timer, the 
control switches the bank in. If it remains continuously below the Single-
Phase kvars at Which Bank Switches Out threshold for the duration of the 
timer, the control switches the bank out.

Note: The voltage must remain in a range where switching the capacitor bank will 
not cause a Voltage Override condition. Otherwise, to avoid excessive cycling, the 
control will not switch the bank. See the “Voltage Override Operation” section in S&C  
Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: Setup,” or 
details.

Control Operation

Var with Temperature Override Control Strategy (var controls only)
When the Automatic Operation mode is enabled and the capacitor control is in Var 
with Temperature Override strategy, it switches the capacitor bank based on single-
phase kvars, kilovolt-amperes, reactive. The control uses the following logic to determine 
when to switch the capacitor bank:

STEP  1.  The capacitor control monitors the single-phase kvar level.

STEP  2.  When the control senses the kvars have passed the Single-Phase kvars at 
Which Bank Switches In threshold (or the Single-Phase kvars at Which 
Bank Switches Out threshold), it starts the Var Change Time Threshold 
timer.

STEP  3.  If the single-phase kvar level remains continuously above the Single-Phase 
kvars at Which Bank Switches In threshold for the duration of the timer, the 
control switches the bank in. If it remains continuously below the Single-
Phase kvars at Which Bank Switches Out threshold for the duration of the 
timer, the control switches the bank out.

STEP  4.  In addition, when the control senses the air temperature has passed the  
Temperature at Which Bank Switches In threshold (or the Temperature 
at Which Bank Switches Out threshold), it starts the High-/Low-
Temperature Change Time Threshold timer. This is true for either high-
temperature or low-temperature operation.
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Current Sensor Location and Reverse Current Flow
For var capacitor controls, the preferred location of the current sensor is on the source 
side of the bank. This lets the sensor measure the effect of the bank when it is online. 
However, the capacitor control can still account for the effect of the bank when the sensor 
is on the load side. This is particularly useful when abnormal circuit switching reverses 
the direction of power flow, flipping the relative position of the sensor.

When a Reverse Current condition exists, the value of the Reverse Current  
Strategy setpoint determines how the control responds. The Adj. Var setting is the 
default.

• Adj. Var—During a Reverse Current condition, if the current sensor is on the normal 
source side, the control calculates the Adjusted 3-Phase kvars level by subtracting 
the 3-Phase Bank Size setpoint from the Measured 3-Phase kvars level. See the 
Setup>Site-Related screen. If the current sensor is on the normal load side, the control 
uses the measured kvars.

• Trip & Inh.—The control switches the bank offline during a Reverse Current  
condition and inhibits further switching until the condition clears.

• Volt Only—During a Reverse Current condition, the control switches the bank based 
only on the presently active Normal and Emergency Voltage-Override setpoints. If 
any neutral sensor strategies are enabled, they remain in effect.

• When the control is in one of the Current or Var control strategies when the  
current reverses, the Volt Only strategy takes precedence over the High-/Low-Band 
Error strategy; if applicable, the Temperature Override function is also discon-
tinued. When current flow returns to normal, the control returns to switching the 
bank based on its regular strategy and the present conditions, including the Bank 
Voltage Change + Margin condition previously in use; this value does not change 
while current is reversed.

• When the control is not in one of the Current or Var strategies when the  
current reverses, it uses the High-/Low-Band Error logic in effect.

Sensor Location

For high-temperature operation, if the temperature remains continuously  
above the Temperature at Which Bank Switches In threshold for the  
duration of the timer, the control switches the bank in, if it is not already 
switched in. If it remains below the Temperature at Which Bank Switches 
Out threshold for the duration of the timer, the control reverts to operation 
based on Var settings.

For low-temperature operation, if the temperature remains continuously 
below the Temperature at Which Bank Switches In threshold for the 
duration of the timer, the control switches the bank in, if it is not already 
switched in. If it remains above the Temperature at Which Bank Switches 
Out threshold for the duration of the timer, the control reverts to operation 
based on Var settings.

Note: The voltage must remain in a range where switching the capacitor bank will  
not cause a Voltage Override condition. Otherwise, to avoid excessive cycling,  
the control will not switch the bank. See the “Voltage Override Operation” section 
in S&C Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: 
Setup,” for details.

Control Operation
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Figure 6 on page 26 shows the four possible combinations of the current sensor  
location and direction of current flow:

1. Sensor on Normal Source Side with Normal Current Flow

The kvar level measured at the sensor location already reflects the effect of the bank. 
The Adjusted 3-Phase kvars level equals the Measured 3-Phase kvars level (which is 
the measured single-phase kvars multiplied by 3).

2. Sensor on Normal Source Side with Reverse Current Flow

Abnormal circuit switching has caused the current direction to reverse. In this case, 
the effect of the bank is not reflected in the measured kvars at the sensor location. 
The capacitor control calculates the Adjusted 3-Phase kvars level by subtracting the 
3-Phase Bank Size setpoint on the Setup>Site-Related screen from the Measured 
3-Phase kvars level.

For example, an online 1200-kvar capacitor bank is set to switch out at -750 kvar. 
The sensors are on the source side and current flow is reversed. When the load at the 
sensor location is 450 kvar, the Adjusted 3-Phase kvars level is 450-1200 = -750 kvar, 
and the bank switches out.

3. Sensor on Load Side with Normal Current Flow

This occurs when the current sensor is installed on the load side of the bank or if 
permanent circuit switching causes the sensor to be on the load side of the bank. See 
No. 2, “Sensor on Normal Source Side with Reverse Current Flow.”

4. Sensor on Load Side with Reverse Current Flow

See No. 1, “Sensor on Normal Source Side with Normal Current Flow.”
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Figure 6. Combinations of current sensor location and direction of current flow.
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Neutral Current 
Detection

The Neutral Current Sensing option allows the capacitor control to monitor and take  
action on abnormal levels of current flowing from the starpoint of a grounded, wye-
connected bank to the system neutral and/or ground. See Figure 7. The sensed current 
is the vector sum of the three capacitor phase currents plus harmonic currents. Factors 
contributing to neutral current include:

• Unequal capacitance between phases of the capacitor bank (This may result from  
manufacturing tolerances or the partial failure of individual capacitor units.)

• A voltage imbalance between individual phases of the distribution circuit

• Harmonic distortion of the line current (A variety of sources can cause harmonic  
distortion, such as lightning, welding, solid state variable speed drives, and equipment 
using switching power supplies.)

• The opening or disconnection of one or two phases of the capacitor bank caused by 
a blown fuse, a failed switch, or defective wiring

Configure the capacitor control to detect abnormal levels of neutral current  
and generate alarms, both in Automatic Operation mode and in Manual  
Operation mode. If desired, a capacitor control in Automatic Operation mode can also  
take appropriate corrective action. See the Setup>Neutral Sensor screen in S&C  
Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: Setup,” for details.  
Maintenance personnel can then diagnose and correct the identified problem.

 WARNING
The individual capacitor units retain a high-voltage charge for several minutes after 
they are disconnected and must be short circuited and grounded before running 
tests . To avoid risk of serious injury only trained personnel should clear and test 
the capacitors .

Figure 7. Neutral current sensor and wye-connected bank with starpoint.
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The capacitor control uses the following logic to determine when to trigger the  
Neutral Current alarm:

STEP  1.  The capacitor control monitors current flowing between the starpoint and the  
system neutral and ground.

STEP  2.  When the control senses current flow has exceeded the Neutral Current 
Alarm Level threshold, it starts the Neutral Current Change Time 
Threshold timer. 

STEP  3. If the neutral current remains continuously above the setpoint for the duration 
of the timer, the control takes one of the following actions:

• When the Neutral Current Corrective Action setpoint is disabled, the  
capacitor control displays error messages on the Operation and 
Diagnostics>Alarms screens, and **Active Alarms** on the LCD screen. 
The Automatic Operation mode is disabled until someone clears the alarm 
from the faceplate or from the Diagnostics>Alarms screen

• When the Neutral Current Corrective Action setpoint is enabled and 
there was no recent switching activity (see Instruction Sheet 1024-530, 
“IntelliCap 2000 Automatic Capacitor Control: Setup”), the capacitor  
control takes the bank offline, if it is not already offline. The capacitor control  
displays error messages on the Operation and Diagnostics>Alarms screens, 
and **Active Alarms** on the LCD screen. Automatic Operation mode 
is disabled until someone clears the alarm from the faceplate or from the 
Diagnostics>Alarms screen

• When the Neutral Current Corrective Action setpoint is enabled and there 
was recent switching activity, the capacitor control tries to reverse the last 
action after the Reclose Block delay, if applicable

When the Neutral Current Retry setting is also enabled, the control 
operates the bank again. If the neutral current level is normal, the alarms 
clear and the control returns to normal operation. Otherwise, the control 
returns the bank to the Corrective Action state. The Automatic Opera-
tion mode is blocked until someone clears the alarm from the faceplate or 
from the Diagnostics>Alarms screen. The capacitor control displays error 
messages on the Operation and Diagnostics>Alarms screens and **Active 
Alarms** on the LCD screen.

When the Neutral Current Retry setting is disabled, the control blocks 
the Automatic Operation mode after the corrective action. The capacitor 
control displays error messages on the Operation and Diagnostics>Alarms 
screens and **Active Alarms** on the LCD screen. Automatic Operation 
mode is disabled until someone clears the alarm from the faceplate or from 
the Diagnostics>Alarms screen.

The capacitor control uses the following logic to determine when to trigger the  
Neutral Current alarm:

STEP  1.  The capacitor control monitors current flowing between the starpoint and the  
system neutral and ground.

STEP  2.  When the control senses current flow has exceeded the Neutral Current 
Alarm Level threshold, it starts the Neutral Current Change Time 
Threshold timer.
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NOTICE
Do not enable Automatic Operation mode until the condition that triggered the 
Neutral Current alarm is cleared .

When trying to reset the alarm and the condition is still present, the alarm  
messages become active again .

Note: If a switch-out attempt triggers the Neutral Current alarm and the Neutral 
Current Corrective Action setpoint is enabled, the capacitor control switches the 
bank back online in case one of the bank switches did not operate correctly. The con-
trol does this to avoid system imbalances caused by only some of the phases being 
online.

STEP  4. In addition, if the control detects a Zero Neutral Current condition for a  
period of time specified by the Zero Neutral Current Detection threshold (if 
enabled), it sets the Zero Neutral Current alarm. The control does not try any 
corrective action and does not lockout the bank. The alarm clears when the 
Zero Neutral Current condition clears or when a Lockout Reset procedure 
is performed.

STEP  5. The user may select whether the control alarms on the Fundamental (60 Hz) 
component of the neutral current or on its Total RMS value. The user may also 
select if the control data logs Fundamental or Total RMS values.

The Neutral Voltage Sensing option allows the capacitor control to monitor and take  
action on abnormal levels of voltage on the starpoint of an ungrounded, wye-connected 
bank. See Figure 8 on page 30. The sensed voltage is the vector sum of the three capacitor 
phase voltages plus harmonic voltages. Factors contributing to neutral voltage include:

• Unequal capacitance between phases of the capacitor bank (This may result from  
manufacturing tolerances or the partial failure of individual capacitor units.)

• A voltage imbalance between individual phases of the distribution circuit

• Harmonic distortion of the line voltage (A variety of sources can cause harmonic  
currents, which can cause harmonic voltage distortion. Examples include lightning, 
welding, solid state variable speed drives, and equipment using switching power  
supplies.)

• The opening or disconnection of one or two phases of the capacitor bank due to a 
blown fuse, a failed switch, or defective wiring

Configure the capacitor control to detect abnormal levels of neutral voltage and 
generate alarms, both in Automatic Operation mode and in Manual Operation 
mode. If desired, a capacitor control in Automatic Operation mode can also take  
appropriate corrective action. See the Setup>Neutral Sensor screen in Instruction Sheet 
1024-530, “IntelliCap 2000 Automatic Capacitor Control: Setup,” for details. Maintenance 
personnel can then diagnose and correct the identified problem.

 WARNING
The individual capacitor units retain a high voltage charge for several minutes after 
they are disconnected and must be short circuited and grounded prior to running 
tests . To avoid risk of serious injury only trained personnel should clear and test 
the capacitors .

Neutral Voltage 
Detection

Control Operation
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Figure 8. The neutral voltage sensor and wye-connected bank with starpoint.
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The capacitor control uses the following logic to determine when to trigger the  
Neutral Voltage alarm:

STEP  1.  The capacitor control monitors the voltage between the starpoint and ground.

Note: Neutral voltage monitoring begins 5 minutes after opening the  
capacitor bank so trapped voltages can discharge.

STEP  2.  When the control senses voltage has exceeded the Neutral Voltage Alarm 
Level threshold, it starts the Neutral Voltage Change Time Threshold 
timer.

STEP  3.  If the neutral voltage remains continuously above the setpoint for the duration 
of the timer, the control takes one of the following actions:

• When the Neutral Voltage Corrective Action setpoint is disabled, 
the capacitor control displays error messages on the Operation and 
Diagnostics>Alarms screens and the Active Alarms field on the LCD  
screen. Automatic Operation mode is disabled until someone clears the 
alarm from the faceplate or from the Diagnostics>Alarms screen.

• When the Neutral Voltage Corrective Action setpoint is enabled 
and there was no recent switching activity (see S&C Instruction Sheet  
1024-530, “IntelliCap® 2000 Automatic Capacitor Control: Setup”), the capacitor  
control takes the bank offline if it is not already offline. The capacitor control  
displays error messages on the Operation and Diagnostics>Alarms screens 
and the Active Alarms field on the LCD screen. Automatic Operation 
mode is disabled until someone clears the alarm from the faceplate or from 
the Diagnostics>Alarms screen.

• When the Neutral Voltage Corrective Action setpoint is enabled and there 
was recent switching activity, the capacitor control tries to reverse the last 
action after the Reclose Block delay, if applicable.

When the Neutral Voltage Retry function is also enabled, the con-
trol operates the bank again. If the Neutral Voltage level is normal, the 
alarms clear and the control returns to normal operation. Otherwise, the 
control returns the bank to the Corrective Action state. Automatic  
Operation mode is blocked until someone clears the alarm from the faceplate 
or from the Diagnostics>Alarms screen. The capacitor control displays error  
messages on the Operation and Diagnostics>Alarms screens, and the Active 
Alarms field on the LCD screen.

When the Neutral Voltage Retry function is disabled, the control blocks 
the Automatic Operation mode after the corrective action. The capacitor 
control displays error messages on the Operation and Diagnostics>Alarms 
screens, and the Active Alarms field on the LCD screen. Automatic  
Operation mode is disabled until someone clears the alarm from the  
faceplate or from the Diagnostics>Alarms screen.

Note: If a switch-out attempt triggers the Neutral Voltage alarm and the 
Neutral Voltage Corrective Action setpoint is enabled, the capacitor con-
trol switches the bank back online in case one of the bank switches did not 
operate correctly. The control does this to avoid system imbalances caused 
by only some of the phases being online.
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STEP  4. In addition, if the control detects a Zero Neutral Voltage condition for a 
period of time specified by the Zero Neutral Voltage Detection threshold (if 
enabled), it sets the Zero Neutral Voltage alarm. The control does not try any 
corrective action and does not lock out the bank. The alarm clears when the 
Zero Neutral Voltage condition clears or when a Lockout Reset procedure 
is performed.

STEP  5. The user may select whether the control alarms on the Fundamental (60 Hz) 
component of the neutral voltage or on its Total RMS value. The user may also 
select whether the control data logs Fundamental or Total RMS values.

NOTICE
Do not enable Automatic Operation mode until the condition that triggered the 
Neutral Voltage alarm is cleared .

If the condition is still present and the alarm is reset, the alarm messages become 
active again .

When the SCADA Override setpoint is enabled via the IntelliLink software or a SCADA  
command, the SCADA master station can choose the capacitor bank state and the  
voltage range in which the SCADA Override function is active. The capacitor control 
uses the following logic to determine when to switch the capacitor bank:

STEP  1.  The SCADA master station sends a Close or Open request to the capacitor 
control.

STEP  2.  The control switches the bank and stays in that state for the length of the 
SCADA Override Timeout Threshold setting. If the setpoint is set to the 
Latched setting, the control remains in that state indefinitely, except during 
Voltage Override conditions. If the control does not receive a new SCADA 
Override command during this time period, the SCADA Override state ends 
and the control returns to its regular Automatic strategy.

Note: The control will not switch the capacitor bank if the control is already 
in Voltage Override mode or if switching would put it into Voltage Override 
mode. If the voltage later returns to a level where switching is allowed and the 
SCADA Override function is still active, the control remembers the SCADA 
command and switches the bank.

STEP  3.  If the Use the Following Voltage Overrides setpoint is set to the Yes setting, 
the control uses the Voltage Override values on the Setup> 
Communications>SCADA Override screen while the SCADA Override 
state is active. Otherwise, it uses the Voltage Override values for the present 
season.

Note: The voltage must remain in a range where switching the capacitor bank 
will not cause a Voltage Override condition. Otherwise, to avoid exces-
sive cycling, the control will not switch the bank. See the “Voltage Override  
Operation” section in S&C Instruction Sheet 1024-530, “IntelliCap® 2000  
Automatic Capacitor Control: Setup,” for details.

SCADA Override 
Strategy
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Use the voltage and/or var values before and after switching in the Voltage Levels 
During Switching and Kvar Levels During Switching screens to find possible switching  
errors.

Note: These screens do not exist now but will be included in a future software release. 
Voltage and kvar levels are now shown on the Logs>Historic Log screen.

An Error condition exists when the change in voltage (ΔV) is less than the Minimum 
Percentage of Average Delta Voltage threshold over the last four switching operations 
or if the change in kvars (Δkvar) is less than the Minimum Percentage of Average 
Delta kvars threshold over the last four switching operations. These percentages are 
set on the Setup>General>Site-Related>Bank-Related screen.

If the average ΔV is at least 0.80 V, the capacitor control can use ΔV to detect errors. If  
current sensors are on the source side of the bank, it can use Δkvar. When conditions are 
favorable for both methods, the capacitor control uses ΔV and Δkvar and flags an error 
only when they agree that an error occurred. If conditions are favorable for one method 
only, the control uses that method to flag errors.

Note: For error-detection analysis, the capacitor control does not use the ΔV and Δkvar 
from a forced retry (the attempt to manually switch the bank into the state already 
indicated).

High/Low Voltage Band Error Operation
The High-/Low-Voltage Band Error condition occurs when the Bank Voltage Change +  
Margin (BVC+M) voltage exceeds the voltage difference of the Season Strategy High-/
Low-Voltage Override setpoints on the Setup>Seasons screen. When this condition occurs, 
the High-/Low-Voltage Band Error condition is set. The Control Status display on the  
IntelliLink Operations screen shows “ERROR.” The High-/Low-Voltage Band Error  
condition status is reported on the Diagnostics>Error screen and the Logs>Status Point 
Log screen. The Emergency High-/Low-Voltage Override modes are used in place of the  
Season Override mode while the High-/Low-Voltage Band Error condition is active. 
When the condition persists continuously for the duration of the High-/Low-Band 
Lockout Time Threshold timer, the High-/Low-Voltage Band Lockout error is set.

When either the High-/Low-Voltage Band Lockout or the Emergency High-/Low-Voltage 
Band Lockout error is set, automatic operation of the bank switch is inhibited, except 
to allow the bank switch to open for a High-Voltage condition. This status is reported 
on the Diagnostics>Error screen and the Logs>Status Point Log screen.  The High-/
Low-Voltage Band Lockout error is also set if either Emergency Voltage Override 
Time Threshold setting is in the Disabled state or the BVC+M value is greater than the 
difference of the Emergency High-/Low-Voltage Override settings, during a High-/
Low-Voltage Band Error condition.

The High-/Low-Voltage Band Error condition will automatically clear if the BVC+M 
value is being automatically calculated, and subsequent switch operations result in the 
calculated BVC+M value becoming less than the difference of the Season Strategy 
High-/Low-Voltage Override settings. The High-/Low-Voltage Band Lockout error 
cannot be automatically cleared.

Detecting  
Switching Errors
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Faceplate Operation 
States

The state of the faceplate LEDs determines which method(s) can be used to switch the 
capacitor bank in and out. Table 4 shows the possible combinations and how each affects 
the ability to operate the bank.

Table 4. Capacitor Bank Operation and Control States

Faceplate State

Control Operating 
Mode

Operate Bank From

Operation 
Mode

SCADA 
Control

Faceplate

Operation 
Screen 

(IntelliLink 
software)

SCADA 
Master 
Station

Manual Local Manual Yes Yes No

Manual Remote SCADA No Yes Yes

Auto Local Automatic No No No

Auto Remote Automatic No No Yes

The following rules apply for whatever method used to switch the bank:

• An energized capacitor bank cannot be reclosed until the Reclose-Block 
timer expires after the bank is opened. The Reclose Block feature pro-
vides time for the capacitor charge to bleed off. The bottom line of the LCD 
screen and the Reclose Block field on the Operation screen show the time 
remaining until the control can switch in the bank. The OPEN LED on the  
faceplate blinks slowly when the Reclose Block state is in effect. (For details about 
cancelling the Reclose Block function during in-shop testing, see S&C Instruction 
Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: Setup.”

• The Manual-Operation Delay setpoint on the Setup>General>Site-Related>Operation 
screen (for both opening and closing the bank) can be configured to allow time for 
an operator to step away from the bank after pressing the CLOSE or OPEN but-
ton. When this delay is set, the CLOSE or OPEN LED starts blinking to indicate the  
pending action. The operation can be cancelled at any time before the Manual-
Operation Delay timer expires by switching to the Auto Operation mode.

Note: When an operation is manually cancelled, be sure to set the Manual mode to 
prevent the bank from switching automatically.

• The red CLOSE LED illuminates when the capacitor bank switch is closed; it blinks 
while the Reclose-Block Timer is running. The green OPEN LED illuminates when 
the capacitor bank switch is open; it blinks while the Reclose-Block timer is running.

• When powering-up the capacitor control for the first time or if the control soft-
ware has been reloaded (not updated), the LEDs do NOT indicate the bank 
state until a switching operation has been performed. To make the LEDs 
indicate the bank state, operate the bank manually or wait for an automatic 
operation to occur. If the capacitor control was in Manual mode and set to  
Automatic mode, it waits 60 seconds before switching. This allows the operator to 
step away from the bank before it operates
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Switching the Capacitor Bank

Manual Operation NOTICE
When the MANUAL and LOCAL LEDs are on, the capacitor control blocks  
Automatic and SCADA operation of the capacitor bank . The bank can only be 
operated from the faceplate or from the Operation screen .

To use the faceplate buttons to switch the capacitor bank in or out:

STEP  1.  Confirm that:

(a) The faceplate LCD screen shows **Unit OK**. If the display does not show 
**Unit OK**, see the “Faceplate” section on page 8.

(b) The OPEN LED is NOT blinking, If the OPEN LED is blinking slowly, the 
Reclose Block timer is running. Wait until blinking stops before trying to 
switch the bank.

(c) The MANUAL LED is lit. When the AUTO LED is lit, pressing the CLOSE or 
OPEN button has no effect.

(d) The LOCAL LED is lit.

STEP  2.  Following company procedures, press the CLOSE or OPEN button on the 
faceplate to operate the capacitor bank.

(a) To transmit a Close command to the capacitor bank switch, press the 
CLOSE button.

(b) To transmit an Open command to the capacitor bank switch, press the 
OPEN button.

Local Bank Operation with IntelliLink Software
To use IntelliLink software to switch the capacitor bank:

STEP  1.  On the Operation screen, confirm that:

(a) The OPEN LED is NOT blinking. If the OPEN LED is blinking slowly, the  
Reclose Block timer is running. Wait until blinking stops before trying to 
switch the bank.

(b) The MANUAL LED is lit. If the AUTO LED is lit, clicking the Close or  
Open field has no effect.

(c) The LOCAL LED is lit.

STEP  2.  Following company procedures, click on the Close or Open field on the 
Operation screen to operate the capacitor bank.

(a) To transmit a Close command to the capacitor bank switch, click the Close 
field.

(b) To transmit an Open command to the capacitor bank switch, click the 
Open field.
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Remote Bank Operation from the SCADA Master Station or WinMon 
Graphical User Interface Software
The capacitor bank can be closed or opened from a SCADA master station or with S&C 
WinMon software. The control must be in Remote mode (the REMOTE LED is lit) to 
accept commands from the SCADA master station or the WinMon software. For more 
information about WinMon Graphical User Interface Software, contact your local S&C 
Sales Representative.

To enable automatic operation of the capacitor bank, confirm the faceplate AUTO LED 
is lit. The software in the capacitor control switches the bank automatically, based on 
the values entered when the control was configured. For an explanation of the available 
switching strategies, see the “Control Strategies” section on page 15.

Automatic Operation

Switching the Capacitor Bank
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Data Graphing

The Graphs>High-Low screen contains graphs that plot the high and low values for 
Voltage, Temperature, Current, Power Factor, kvar, kW, and Neutral Sensor. Each graph 
is a first-in first-out buffer showing the most data the time line allows. 

The displayed data cannot be extracted from the Graphs screens. However, 52 Daily 
High-Low files can be downloaded from the Metering Data folder by opening the Tools 
drop-down menu and then clicking on the Compact Flash Access entry. Any of the 52 
files can be selected and saved. Use the Modification Time field to find the most recent 
data. Use the S&C WaveWin program to view the file content and export data to a .csv file.

The control automatically scales each graph to show as much detail as possible.

Note: Generation of the Power Factor high and low values uses the Power Factor Sign 
Convention setpoint on the Setup>General>Site-Related screen.

The Graphs>Sensor Profiles screen contains graphs that plot the daily averaged values 
for Voltage, Temperature, Current, Power Factor, kvar, kW, and Neutral Sensor. Each 
graph is a first-in, first-out buffer showing the most recent data the timeline allows. 
The Time Average for Metering function is configured on the Setup>General>Site-
Related>Log screen.

The displayed data cannot be extracted from the Graphs screens. However, 30 Daily 
High-Low files can be downloaded from the Metering Data folder by opening the Tools 
drop-down menu and then clicking on Compact Flash Access entry. Any of the 30 files 
can be selected and saved. Use the Modification Time field to find the most recent data. 
Use the S&C WaveWin program to view the file content and export data to a .csv file.

Note: Neutral sensor data may be logged as either Fundamental or Total RMS data, 
which is selected on the Setup>General>Sensor Configuration>Neutral Current Sen-
sor screen with the Alarm Base Component setting.

Note: Generation of the Power Factor graph uses the Power Factor Sign Convention 
setpoint on the Setup>General>Site-Related screen.

High-Low Graphs

Sensor Profile Graphs

Figure 9. The Graphs>Sensor Profiles>Voltage screen.
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Generating Reports

Use the Report feature to save the control software settings and stored data to the 
computer as a comma-separated value (CSV) file. The report can be kept as a permanent  
record and the report data used in spreadsheets or other program types.

Follow these steps to use the Report feature:

STEP  1.  Connect the computer to the capacitor control and start the IntelliLink  
software.

For details, see the “To Start the IntelliLink Software” section in Instruction 
Sheet 1024-530, “IntelliCap 2000 Automatic Capacitor Control: Setup.” If the 
computer is already connected to the capacitor control, skip this step.

STEP  2.  From the Data menu, choose the Reports option.

STEP  3.  In the dialog box, select the type of report to be generated. Then, click on the 
OK button. There are four types of reports:

(a) Full—Includes all the information contained in the capacitor control

(b) System Setup and Operation—Contains the configuration data for the 
capacitor control

(c) Troubleshooting Information—Contains the information recorded in 
the troubleshooting logs

(d) Historical Data—Contains the daily statistics, sensor profiles, switching 
data, and log of power outages

STEP  4.  In the Save Report dialog box, specify the name and location for this report. 
Then, click on the OK button. If a file location is not specified, the file is saved 
to the same directory as the program files for this type of control (for example, 
the default location for PCSD1-S report files is C:\S&C Electric\PCSD---S\). The 
extension “.csv” is added automatically.

STEP  5.  When the report is complete, the Task completed message appears on the 
status line of the Writing Report dialog box.
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Setup Configurations

When severa l capacitor controls use a simi lar setup conf igurat ion, the  
configuration file can be saved from one control and load into the others, replicating the 
saved configuration. Then, specific setpoints can be manually adjusted in each control.

A configuration file should be used with control software that is the same revision as 
the software used to create the configuration file. However, a file created by a different 
software revision can be used. Software revisions may add setpoints for new features. 
If the configuration file was created with older software, only the setpoints available in 
the older software will be configured, and setpoints for new features will be set to the 
default value. If newer software created the configuration file, setpoints not present in 
the target control will not be added by the configuration file.

NOTICE
With firmware version 2 .3 .x and later, the default passwords for all user accounts, 
including the admin account, must be changed before IntelliLink software 
can connect to and configure a control . See S&C Instruction Sheet 1024-530, 
“IntelliCap® 2000 Automatic Capacitor Control: Setup,” for more information .

To save a setup configuration:

STEP  1.  Determine which capacitor control contains the configuration to be saved.

STEP  2.  Connect the computer to the selected control and start IntelliLink software.

For details, see the “Start IntelliLink Software” section in S&C Instruction Sheet  
1024-530, “IntelliCap® 2000 Automatic Capacitor Control: Setup.” If the com-
puter is already connected to the capacitor control, this step can be skipped.

STEP  3.  Click on the File button. Then, click on the Save Setpoints button. The Save 
Setpoints dialog box will open.

STEP  4.  In the Save Setpoints dialog box, specify a name and location for this 
configuration file, select the setpoints to include, and then click on the Save 
button.

If a location does not need to be specified, the file is saved to the same 
directory as the program files for this type of control (for example, the default 
location for PCSD1-S report files is C:\S&C Electric\PCSD---S\). The extension 
“.cfg” is added automatically.

Note: This process does not save the information on the Setup>General>Site-
Related>Device screen.

Saving a Setup 
Configuration
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Follow these steps to load a saved configuration:

STEP  1.  If necessary, connect the computer to the capacitor control where the 
configuration is to be loaded. Then, start the IntelliLink software.

For details, see the “Start IntelliLink Software” section in S&C Instruction 
Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: Setup.” If the 
computer is already connected to the capacitor control, skip this step.

STEP  2.  From the File menu, choose the Load Setpoints option.

STEP  3.  In the dialog box, select the “.cfg” file for the configuration to be loaded. Then, 
click on the Open button.

STEP  4.  Make any setpoint changes that are required for this capacitor control.

For details, see Instruction Sheet 1024-530, “IntelliCap 2000 Automatic 
Capacitor Control: Setup.”

When loading a configuration file that was saved from a previous software 
revision, it may not configure all the setpoints included with the newer software. 
The older configuration file will successfully load the data it contains, and the 
new setpoints will remain set at their default values. If the default values need 
to be changed, they must be manually configured. Refer to the ReadMe.txt file 
included with the new software for information about newly added setpoints.

NOTICE
Be sure to enter the correct values on the Setup>General>Site-Related>Device 
and the Setup>Communications screens .

Loading a Saved 
Configuration
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Using IntelliLink Software Without a Control

To view the IntelliLink software screens and Help file without connecting to a control 
or a snapshot:

STEP  1.  Start the IntelliLink software on the computer.

STEP  2.  During startup, click on the Cancel button to close the Connect dialog box.

If the IntelliLink software is already running, choose the Disconnect option 
from the Connection menu. Then, screenset from memory.

STEP  3.  From the File menu, choose the Open Screenset option.

STEP  4.  In the Open Screenset dialog box, find and select the .WMN file whose name 
matches the version name on the setup software for this control.

Using a Screenset

The operational and data-logging information can be saved in snapshots, which are 
“.vm” virtual memory files. The snapshots are used to view data, generate a report, and 
save or change setpoint configuration files, even when the computer is not connected to 
a capacitor control. To access the stored information, connect to the snapshot instead 
of the physical control. Capacitor control setup software includes a sample snapshot.

To save control settings and data to a snapshot:

STEP  1.  Connect the computer to the capacitor control from which the information is 
to be saved. Then, start the IntelliLink software.

For details, see the “Start IntelliLink Software” section in S&C Instruction 
Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: Setup.” When 
the computer is already connected to the capacitor control, skip this step.

STEP  2.  From the File menu, choose the Save Snapshot option.

STEP  3.  In the dialog box, specify a file name and location for this snapshot. Then, click 
on the Save button.

If a file location is not specified, the file is saved to the same directory as 
the program files for this type of control (for example, the default location 
for PCSD1-S report files is C:\S&C Electric\PCSD---S\). The extension “.vm” is 
added automatically.

Saving a Snapshot
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Using IntelliLink Software Without a Control

To view (connect to) a snapshot:

STEP  1.  Start the IntelliLink software on the computer. During startup, click on the 
Cancel button to close the Connect dialog box.

If the IntelliLink software is already running, choose the Disconnect option 
from the Connection menu. Then, choose the Close Screenset option from 
the File menu to clear the present screenset from memory.

STEP  2.  From the File menu, choose the Open Snapshot option. The Open Controller 
Data File dialog box opens.

STEP  3.  Select the snapshot to use. Then, click on the Open button.

STEP  4.  If planning to change the configuration settings in the snapshot, click on the 
Yes button at the Connect to File dialog box. To avoid accidentally changing a 
setting, click on the No button.

The IntelliLink software opens and displays the contents of the selected 
snapshot.

Viewing a Snapshot

To save any changes made in the snapshot
All changes made to configuration settings in the snapshot are automatically saved to 
disk immediately. There is no need to save the changes in a separate operation.

To generate a report from a snapshot
Follow the same procedure as when connected to a capacitor control. For details, see 
the “Generating Reports” section on page 38.

To create a CFG file from a snapshot
This procedure allows preparing a setpoint configuration for a control in the field while 
there is no access to a comparable control:

STEP  1.  Connect to the snapshot.

For details, see the “Viewing a Snapshot” section above.

STEP  2.  Change the configuration settings in the snapshot as needed.

For details, see S&C Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic 
Capacitor Control: Setup.”

STEP  3.  From the File menu, choose the Save Setpoints option.

STEP  4.  In the Save Setpoints dialog box, specify a name and location for this  
configuration file. Then, click on the Save button.

When a location to save the file is not specified, it is saved to the same 
directory as the program files for this type of control (for example, the default 
location for PCSD1-S report files is C:\S&C Electric\PCSD---S\). The extension 
“.cfg” is added automatically.

NOTICE
Be sure to enter the correct values on the Setup>General>Site-Related>Device 
and the Setup>Communications screens .

Using a Snapshot
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Updating Control Software

Occasionally, the software in a capacitor control may need to be updated. The update  
program, installed with IntelliLink software, easily replaces the existing control  
software with a newer revision.

NOTICE
The setpoint values and historical data stored in the capacitor control may be lost 
during the update process .

To capture the data, always generate all needed reports using the old IntelliLink 
and control software before updating the control software .

NOTICE
Starting with firmware later than version 2 .3 .x, settings validation will be performed 
at the beginning of the update process . If any validation errors are found, these 
must be corrected before upgrading the firmware . Otherwise the control settings 
may not be retained . If this occurs after the upgrade is complete, settings can be 
restored by uploading a saved IntelliLink software setpoint file to the control .

To update the software:

STEP  1.  Install the contents of the new software installer on the computer.

For details, see the “Start IntelliLink Software” section in Instruction Sheet 
1024-530, “IntelliCap 2000 Automatic Capacitor Control: Setup.”

STEP  2.  Connect the computer to the USB port on the capacitor control.

STEP  3.  Select the IntelliLink option from Start>All Programs>S&C Electric screen. 
See Figure 10.

Figure 10. Start button program selection screen.
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Updating Control Software

STEP  4.  Select the Local Connection option. See Figure 11.

Figure 11. The IntelliShell connection program—Select Connection Mode dialog box.

STEP  5. Select the IntelliCap 2000 option from the Product Family menu, and select 
either the Serial or the Wi-Fi button. See Figure 12.

Figure 12. The IntelliShell connection program—Product Family selection dialog box.

STEP  6. Select the Comm Port option used to connect to the control, and select the 
Update Firmware button. See Figure 13.

Figure 13. The IntelliShell connection program—Local Communication Setup dialog box.
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Updating Control Software

NOTICE
When upgrading the control software to version 2 .3 .x and later, the choice is 
offered to retain the passwords or revert to default passwords . When retaining 
passwords, the admin password must not be the default password and must 
meet the new complexity requirements . When reverting to default passwords, 
all default passwords must be changed at the initial login after the upgrade . See 
S&C Instruction Sheet 1024-530, “IntelliCap® 2000 Automatic Capacitor Control: 
Setup,” for more information . 

STEP  7. Log in to the control and follow the dialog instructions. If prompted during the 
upgrade, enter the default username and password. See Figure 14.

Note: If the upgrade is from 2.3.x to a later software release, enter the admin 
non-default password at this step.

Do not skip any of the software components unless instructed by S&C  
Electric Company to do so. If the default username and password are not 
known, contact S&C Electric Company.

Figure 14. The IntelliLink Setup Software Login dialog box.
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IntelliCap® Plus Automatic Capacitor Control Setting Conversion

The following describes the process for converting IntelliCap Plus Automatic Capacitor 
Control settings for use with an IntelliCap 2000 Automatic Capacitor Control:

Note: Windows® PowerShell version 3 or later will be required to execute this 
procedure.

STEP  1.  Click on the Windows Start menu. Open the Accessories>Windows Powershell 
folders, and run Windows Powershell ISE (x86) program. See Figure 15.

Figure 15. The Windows Accessories drop-down menu.

Note: If Windows PowerShell ISE is accidentally chosen, the script will end with a 
message reporting an error.

STEP  2.  Select the File Open option on the main menu and open the UpgradeICPlus 
toIC2000.ps1 script file. See Figure 16. The file is located at:

C:\Program Files (x86)\S&C Electric\Products\IC2000\Firmware\Upgrades\
UpgradeICPlustoIC2000.ps1.

Figure 16. The IntelliCap Plus control firmware upgrade window.
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IntelliCap® Plus Automatic Capacitor Control Setting Conversion

STEP  3. Press the <F5> key to run the upgrade script. A file selection dialog box will 
open. Choose the IntelliCap Plus control settings to be converted. The IntelliCap 
Plus control setting files have a file extension of .cfg. The default location for 
these files is C:\ELINE\PCVD---S. More than one at a time can be chosen to 
upgrade. After selecting the desired files, click on the Open button.

STEP  4. As the script is running, the progress is logged in a blue window within the 
PowerShell window. When the script is finished, a log file opens to show which 
files were converted, what the resulting IntelliCap 2000 control .xspt settings 
files are named, and where they are located. The files are time-stamped.

STEP  5. To upgrade a device with a converted settings file, connect to the device with 
IntelliLink software, and choose the Load Settings option. See Figure 17. 
Choose the file to load, and select which groups of settings to load.

Figure 17. The Load Setpoints setting type selection dialog box.
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